
A
P

P
L

IC
A

T
IO

N
 N

O
T

E
S

 

 
 

General How to Update the PmmC 

for Goldelox 

DOCUMENT DATE:  13th April 2019 

DOCUMENT REVISION: 1.1 

W W W . 4 D S Y S T E M S . C O M . A U  



APPLICATION NOTES  4D-AN-00041 
 

 
Page 2 of 19   www.4dsystems.com.au 

  Description 

This application note provides step-by-step instructions on how to power up 

the display module and update the firmware or PmmC (Personality-module-

micro-Code). 

 

Before getting started, the following are required: 

 

 Any of the following 4D Goldelox display modules: 

 

uOLED-96-G2 uOLED-128-G2 uOLED-160-G2 

uLCD-144-G2   

 

and other superseded modules 

 

 4D Programming Cable or µUSB-PA5  

 Workshop 4 IDE (installed according to the installation 

document) 
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  Install the Drivers for the Programming Modules 

Either the µUSB-PA5 programming adaptor OR the 4D USB programming 

cable can be used to download a program to, update the firmware or PmmC 

on, or test a Goldelox display module. Before using any of these 

programming modules, the drivers need to be installed first.  

Drivers for the µUSB-PA5 Programming Adaptor 

 

Information about and drivers for 
the µUSB-PA5 programming 
adaptor can be found on its 
product page. Click on the image to 
go to the product page. 

Drivers for the 4D USB Programming Cable 

 

 

http://www.4dsystems.com.au/product/17/115/Accessories/uUSB-PA5/
http://www.4dsystems.com.au/product/17/114/Accessories/4D-Programming-Cable/
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Information about and drivers for the 4D USB programming cable can be 

found on its product page. Click on the image to go to the product page. 

Warning 

Using a non-4D programming interface could damage the processor and 

void the warranty. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  Install Workshop 4 

Workshop 4 is a comprehensive software IDE for Microsoft Windows that 

provides an integrated software development platform for all of the 4D 

family of processors and modules. The IDE combines the Editor, Compiler, 

Linker and Downloader to develop complete 4DGL application code. All user 

application code is developed within the Workshop4 IDE. 

 
Updated installation files and installation guide for Workshop 4 can be found 

on its product page. Click on the image to go to the product page. 

 

 

 

http://www.4dsystems.com.au/product/10/120/Development/4D_Workshop_4_IDE/


APPLICATION NOTES  4D-AN-00041 
 

 
Page 5 of 19   www.4dsystems.com.au 

How to Update the Firmware 

Follow the instructions below to update the firmware or PmmC (Personality 

module micro Code) of the display module. In summary, the instructions are 

as follows: 

 

a) Create a new project in Workshop 

(1) Launch Workshop 4 

(2) Create a new Project 

(3) Select an Environment 

 

b) Connect the display module to the PC 

(1) Connect using the 4D USB programming cable 

(2) Connect using the uUSB-PA5 programming adaptor 

(3) Check if the display module is detected by the PC 

 

c) Open the PmmC loader 

(1) Auto update mode 

(2) Manual update mode 

(3) Force update 

 

 

 

 

 

 

 

 

Create a New Project 

Launch Workshop  4 

There is a shortcut for Workshop 4 on the desktop. Launch Workshop 4 by 
double-clicking on the icon. 
 

 
 

Create a New Project 

Workshop 4 opens and displays the Recent page. 
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To create a new project, there are two options. 
 

 
Click on the top left-most icon, New. 
 

 
 

  
 

Or Click on the icon beside Create a new Project. 
 

 
 

The Choose-Your-Product window appears. 
 

 
 

Select the appropriate screen and preferred orientation. The screen used in 
this example is a uOLED-128-G2 (Landscape orientation). 
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Select an Environment 

Select any of the available environments. In this tutorial, Designer is chosen. 
 

 
 

A new project is created. The user can now update the firmware on the 

display module and can start designing an application as well. Workshop 4 

displays a simple 4DGL code which the user can improve. 

 

 

 

 

 

 
 

To learn how to create a basic application in Designer, read Designer Getting 

Started - First Project. 

 

 

 

 

 

 

 

 

http://www.4dsystems.com.au/appnote/4D-AN-00117/
http://www.4dsystems.com.au/appnote/4D-AN-00117/
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Connect the Display Module to the PC 

Connect the display module to the PC using a 4D USB Programming Cable or 

a µUSB-PA5 programming adaptor.  

 

Connection using a 4D USB Programming Cable 

Complete Setup 

 

 

 

 

 

 
 

 

 

 

 

Check orientation of connection 

  
 

Connection using a uUSB-PA5 

Complete Setup 

 

 

 

 

 

One end of the programming 

cable is connected to the 

display module 

The other end of the 

programming cable is 

connected to the PC 

C
 

C
 

The other end of 

the 5-way cable 

is connected to 

the uUSB-PA5. 

One end of the 5-way 

cable is connected to 

the display module. 

C
 

The uUSB-PA5 is 

connected to a USB-

to-miniUSB cable. 

C
 

http://www.4dsystems.com.au/product/17/114/Accessories/4D-Programming-Cable/
http://www.4dsystems.com.au/product/17/115/Accessories/uUSB-PA5/
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Check orientation of connections 

  
 

 

 

 

 

 
 

 

 
 

 

 

Check if the Display Module is Detected by the PC 

Go to the Comms menu to check if the module is detected.  

 

 

 

 

The violet light mentions no programming module is currently connected. 

 

USB to miniUSB cable 

connected to the PC 

µUSB-PA5 

programming 

adaptor 

5-way cable 

going to the 

display module 

 

 C 
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With the display module connected to the 4D USB programming cable (or 

µUSB-PA5), plug the cable into the USB port. Click on the drop-down list and 

select the COM port allocated to the cable. The product pages for the 

programming cable and µUSB-PA5 have instructions on how to determine 

the allocated COM port. 

 

The light turns yellow while the connection is being established: 

  

Finally, the light goes blue when the connection is established. 

 

 

 

 

  

 

Note that the model of the target display and its current PmmC are printed 

in red font, which means that a later version of the PmmC is available in 

Workshop. In this case, the outdated PmmC on the target display is version 

2.4. The latest available version is 2.5 or higher.  

 

The light turns red when no module is attached to the selected port: 

  

 

If the connected target display cannot be detected, double check all 
connections, ensure that the drivers are correctly installed, and verify the 
correct COM port allocation for the programming module. Check continuity 
of the 5-way cable and try replacing the USB-to-miniUSB cable (if using a 
uUSB-PA5) as well. Some USB-to-miniUSB cables transfer power only and 
not data. 
 

 

 

 C 

 C 

 C 
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Open the PmmC Loader 

Workshop uses the PmmC loader to download a PmmC onto the display 
module. To open it, go to the Tools menu and click on the PmmC Loader 
icon. 
 

 
 
 

The PmmC Loader window appears. 
 

 
 

 

Auto Update Mode 

By default, the mode is set to automatic.  
 

 
 

Select the appropriate Com Port by clicking the drop-down menu arrow. 
 

  
 
Click on the Auto Update button at the bottom part of the window. 
 

 
 

If the firmware on the display module is up-to-date, the information box will 
display the message shown below. There is no need to update the firmware 
in this case. 
 

 
 

On the other hand, if the PmmC is not up-to-date, the information box will 

display the message shown below. 
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Download is now in progress. 

 
 

Check that the load status is successful. 

 
 

Click on the Auto Update button to check the current firmware. The PmmC 

should now be up-to-date. 

 

 
 

Click on the Close button to exit. 

 

 
 

Go back to the Comms menu and click on the blue button/light to redetect 

the target display.  

 
 

The updated PmmC on the display should now be recognized. 

 

 
 

Manual Update Mode 

Use the manual update mode to manually select the desired PmmC file to 

be downloaded onto the display module. 

 



APPLICATION NOTES  4D-AN-00041 
 

 
Page 13 of 19   www.4dsystems.com.au 

During installation of Workshop, the latest PmmC files are copied to the 

default folder shown below (Windows 8). 

 
 

Previous versions of PmmC files from previous installations of Workshop are 

also retained in this folder. The user may choose the desired and 

appropriate PmmC file to load among the contents of this folder. 

Force Update 

In the Auto Update mode, no action is taken if the PmmC loader detects that 

the firmware is up-to-date. However, it is possible to force the PmmC loader 

to load the latest PmmC file onto the display module. To accomplish this, 

enable the Force-update-to-current-PmmC option by clicking on the tick box 

beside it. 

 
 

Click on the Auto Update button at the bottom part of the window. 

 

Download is now in progress. 

 
 

Check that the load status is successful. 

 
Click on the Close button to exit. 
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How to Open a Sample Project 

Open a Sample Project 

Workshop 4 opens and displays the Recent page. 

 

 

 

 

 

 

 

 

 

To open a sample project, click on the Samples tab. 

 

 

 

Select Goldelox Designer. 
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A standard Open window appears. Open the folder GENERAL EXAMPLES. 

 

  
 

Choose the Designer file “GOLDELOX_CLOCK.4DG”. 

 

 
 

The sample project now opens. 
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How to Change the Screen Module 

Now, check the type of the screen module by selecting the Project menu. 

 

 
 

If using a different display module, change the target display module by 

clicking on the display button.  

 

The Change Display window appears.  

 

 

Select the appropriate screen on the drop-down list and define the 

orientation. 

 

  

 

…and confirm by clicking on . 
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Compile and Download 

Go to the Home menu and click on the Compile button. 

 

 
 

The message box at the bottom part shows no compilation errors. 

 

 
 

 

After making sure that the device is detected, click on the Download button. 

 

 
 

 

 

 

 

If Workshop detects that the PmmC on the target display module is 

outdated, it will display a confirmation dialog box.  

 

 
 

To update the PmmC of the target display, click No then follow the 

procedures described earlier in this document (Auto Update Mode). Make 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 C 
is 
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sure that Workshop recognizes the updated PmmC of the display. The user 

can then repeat the download process. 

 

 
 

The user can also ignore the notification and proceed to loading the program 

by clicking Yes. Either way, Workshop now downloads the program to the 

display module. 

 

 
 

Finally, the message box confirms that the download has been successful. 

 

 
The demo now starts and runs on the screen. Note that a uSD card is not 

needed for this demo. 

 

 C 
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Proprietary Information 

The information contained in this document is the property of 4D Systems Pty. Ltd. and may be the subject of patents pending or granted, and must not be 

copied or disclosed without prior written permission.  

4D Systems endeavours to ensure that the information in this document is correct and fairly stated but does not accept liability for any error or omission. The 

development of 4D Systems products and services is continuous and published information may not be up to date. It is important to check the current position 

with 4D Systems. 

All trademarks belong to their respective owners and are recognised and acknowledged. 

 

  Disclaimer of Warranties & Limitation of Liability 

4D Systems makes no warranty, either expresses or implied with respect to any product, and specifically disclaims all other warranties, including, without 

limitation, warranties for merchantability, non-infringement and fitness for any particular purpose. 

Information contained in this publication regarding device applications and the like is provided only for your convenience and may be superseded by updates. 

It is your responsibility to ensure that your application meets with your specifications. 

In no event shall 4D Systems be liable to the buyer or to any third party for any indirect, incidental, special, consequential, punitive or exemplary damages 

(including without limitation lost profits, lost savings, or loss of business opportunity) arising out of or relating to any product or service provided or to be 

provided by 4D Systems, or the use or inability to use the same, even if 4D Systems has been advised of the possibility of such damages. 

4D Systems products are not fault tolerant nor designed, manufactured or intended for use or resale as on line control equipment in hazardous environments 

requiring fail – safe performance, such as in the operation of nuclear facilities, aircraft navigation or communication systems, air traffic control, direct life 

support machines or weapons systems in which the failure of the product could lead directly to death, personal injury or severe physical or environmental 

damage (‘High Risk Activities’). 4D Systems and its suppliers specifically disclaim any expressed or implied warranty of fitness for High Risk Activities. 

Use of 4D Systems’ products and devices in 'High Risk Activities' and in any other application is entirely at the buyer’s risk, and the buyer agrees to defend, 

indemnify and hold harmless 4D Systems from any and all damages, claims, suits, or expenses resulting from such use. No licenses are conveyed, implicitly or 

otherwise, under any 4D Systems intellectual property rights. 


